User Manual

PVGuard®
Dashboard Designer

Synopsis

Describes how to create and edit Dashboards for PVGuard.

Version

Program Version 2.2

Date

9.12.2015

PVGuard®

Imprint
Copyright ©2014 skytron energy GmbH
Notices
This document is protected by copyright. No parts of it may be copied or translated into other
languages without the express, prior written consent of skytron® energy GmbH. The utmost care and
attention have gone into the preparation of this manual, but skytron® energy GmbH accepts no liability
for any errors that may be contained in this document or may result from using it.
The registered trademarks used in this manual are the property of their respective owners.
The following products are registered trademarks of skytron® energy GmbH:
skytron®
ArrayGuard®
PVGuard®
skylog®
StringGuard®
For any legal issues concerning this document, the place of performance and jurisdiction is Berlin.
Registered Court: Amtsgericht Berlin-Charlottenburg HRB 163298B / DE 295 424 299

Publisher
skytron® energy GmbH Ernst-Augustin-Straße 15 / D - 12489 Berlin
Managing Director: Jörgen Klammer
Tel: +49 30 338 430 - 0 / Telefax: +49 30 338 430 - 99
info@skytron-energy.com / www.skytron-energy.com

2

PVGuard® Contents

Contents
1 Introduction to Dashboards............................................................................5
2 The Dashboard Designer................................................................................ 6
2.1 The Dashboard Designer Program Window...............................................................................6
2.2 Regions of the Window..............................................................................................................6

3 Getting Going................................................................................................. 8

3.1 A First Design............................................................................................................................. 8
3.2 General Hints..............................................................................................................................9

4 Working with Dashboards............................................................................ 10
4.1 Opening a Dashboard in PVGuard........................................................................................... 10
4.2 Creating a new Dashboard.......................................................................................................10
4.3 Opening a Dashboard for Editing.............................................................................................10
4.4 Saving and Previewing your Work........................................................................................... 11
4.5 Deleting and Renaming Dashboards........................................................................................ 11

5 Working with Widgets..................................................................................13
5.1 Inserting a Widget into your Dashboard................................................................................. 13
5.2 Changing the Data Channel in a Widget..................................................................................14
5.3 Changing the Text in a Widget................................................................................................ 14
5.4 Adjusting how a Widget looks: Widget Properties.................................................................. 15
5.5 Some of the Common Widget Properties................................................................................15
5.6 Binding Widgets to Plant Data.................................................................................................16
5.7 The Context Menu for Widgets............................................................................................... 17
5.8 The Widget Hierarchy Pane..................................................................................................... 17
5.9 The Context Menu for the Widget Hierarchy.......................................................................... 18

6 Laying it Out.................................................................................................19
6.1 The Grid....................................................................................................................................19
6.2 Widget Order............................................................................................................................19
6.3 Transparency............................................................................................................................ 19

7 Getting the Data Right................................................................................. 21

7.1 Choosing the Correct Data Channels....................................................................................... 21
7.2 Applying a Conversion Factor.................................................................................................. 22

8 Jazzing it Up: Adding Graphics......................................................................23
8.1 Graphics in Dashboards............................................................................................................23
8.2 The Insert Picture Wizard........................................................................................................ 23

PVGuard® Contents

9 Showing the Trend: Adding Charts............................................................... 26
9.1 How to Add a Chart................................................................................................................. 26
9.2 Insert Chart Wizard.................................................................................................................. 26

10 Joining Everything Together: Using Connectors...........................................29
10.1 How to Add a Connector....................................................................................................... 29
10.2 The Connector Type............................................................................................................... 29
10.3 Fine Tuning: Connector Properties........................................................................................ 30

11 Reference: Toolbar and Canvas Functions...................................................32
11.1 Tabbed_toolbar...................................................................................................................... 32
11.2 The Quick Access Toolbar...................................................................................................... 33
11.3 Working with Multiple Canvases........................................................................................... 33

Introduction to Dashboards

1 Introduction to Dashboards
PVGuard comes with range of pre-defined plant views to cover its users’ needs for power-plant
supervision. These are based on skytron's extensive experience of working with energy generation
systems. However individual users may prefer the monitored data to be displayed in a particular way or
to design their own mimic diagrams, suited to their own arrangement of plants and including their own
branding.
The PVGuard dashboard addresses these requirements by giving skytron's users the ability to design
their own customised plant displays – known as dashboards. In this way, you as a PVGuard user, can
define your own displays that show just the information you need and in exactly the way you want.
All the data channels that you have access to in PVGuard are available to be used in dashboards. In
addition, you can include your organisation's own graphics such as branding and symbols, site maps,
and pictures, equipment graphics and photos. In this way, by using dashboards, you can maximize the
attractiveness and usability of PVGuard.

Fig 1: An example PVGuard dashboard

Dashboards are created using a special tool called the Dashboard Designer. This tool provides you with
a range of basic elements, called widgets. Using these widgets you can assemble sophisticated and
complex dashboard designs.
The various widgets provided can be customized in terms of:
• Their appearance - shape, colour, borders, text, fonts
• What data is displayed - values, data channel names, status values - and how
The basic widgets offered by skytron include elements such as:
• Labels for displaying text and data values
• Bar displays, either horizontal or vertical
• Status “LED” indicators
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2 The Dashboard Designer
Dashboards and the Dashboard Designer are included as standard components of PVGuard. Opening
a dashboard will open it in the same way as other Views in PVGuard. It will include all the normal
PVGuard features such as an adjustable time-bar and automatic refreshing.
The difference between dashboards and other PVGuard plant status views is that the design of a
dashboard is not fixed; you can create, edit and adjust the design of a dashboard as you wish.
The Dashboard Designer allows you to design and edit dashboards. You can open it directly from the
PVGuard menu by using the command View > Open Dashboard Designer.

2.1 The Dashboard Designer Program Window
When you open the Dashboard Designer, the program window will appear as shown below.
Application Quick Access
Button
Toolbar

Dashboard
Overview

Plant
Explorer

Tabbed
Toolbar

Widget
Hierarchy

Dashboard
Canvases

Widget
Properties

Fig 2: The Dashboard Designer Program Window

2.2 Regions of the Window
The Dashboard Designer program window is divided into the following areas:
Quick Access Toolbar and
Application Button

Provides commands to allow you to create a new dashboard, save
a dashboard, refresh the window etc.

Tabbed Toolbar

The main toolbar allows you to create a widget, an element in
a dashboard, and adjust how it is formatted. Clicking on a tab
shows the commands that are relevant to the current dashboard
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, organized into groups. The available commands also depend on
the selected widget.
Plant Explorer

Similar to the one in PVGuard, the Plant Explorer allows you to
select data channels from your portfolio of plants; these can then
be dragged and dropped in to a dashboard.

Dashboard Canvases

The canvases form the main working area of the tool where the
dashboard under development is pictured and worked on. You
can have more than one dashboard open at a time if you want;
each opens in its own canvas in a separate tab. The background
canvas is shown with a dotted grid to help you align the widgets;
they will snap to the grid.

Dashboard Overview

The display may only be big enough to show a small section of the
dashboard you are working on. The Overview provides you with
a thumbnail view of the whole dashboard, and shows you where
the working window is located within it.

Hierarchy

All of the widgets currently being used in the open dashboard
are listed here. Selecting a widget here will also select it in the
main canvas. The order of widgets here also determines how
overlapping widgets will be shown; those at the top of the list are
shown on top of those lower down it.

Widget Properties

This tabbed panel shows you all the properties of the currently
selected widget, and allows you to modify them, so changing the
widget's appearance or behaviour.
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3 Getting Going
It's easy to start developing your first dashboard. The following section walks you through the steps.

3.1 A First Design
In the Dashboard Designer your power plants are shown in the Plant Explorer pane at the left of
the program window. Expand the folder for a plant until you find the device or data channel you
want to display. Click on this entry and drag it into the desired position on the canvas, keeping the
mouse key pressed while you do this.
When you release the mouse key a dialog will pop up. This will show a choice of the widgets that
are available for that type of device or data channel. There may be several choices available. For
example, a power output channel could be shown as: a gauge or a bar display, a label showing the
output as a value or a label showing the name of the channel.
Choose the form you want from the choice and allow it to drop into place.

Dialog
Drop in place

Pull device or
data channel
Device symbol
placed on canvas

Fig 3: Dragging a widget onto the canvas

Carry on dragging devices or data channels from the Plant Explorer until you have completed your
design.
Then, suppose you want to add a title to your dashboard. To do this, pull the widget named Label
from the Gallery group of the Tabbed Toolbar at the top of the program window. Pull it to the
correct place at the top of the canvas, and let it drop.

Pull device
from Gallery

Fig 4: Dragging a widget onto the canvas

If you double click the widget, you will be able to change the text.
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Next, format the label's appearance by selecting it and choosing your desired font size from the
Font group of the Formatting tab in the Tabbed Toolbar. Then adjust the size of the widget by
pulling its handles, so that the text is visible in its entirety.
Set font
size

Pull handles
to resize

Fig 5: Changing the text formatting

While you are laying out your design, you can use the Preview control on the Quick Access Toolbar
at the top of the program window to see how the dashboard will finally look with real data loaded.
When you are satisfied with your design, save it using the Save control. You can find this by clicking
on the Application Button. A dialog will open to let you give the widget a name and description.
After this the dashboard will become available in the View Navigator under the dashboards folder
for the relevant plant.
That's it!

3.2 General Hints
1. You can pull any device into your dashboard, from an individual data channel right through to a
whole power plant.
2. Normally when you pull a device, you will see a small rectangle following the mouse,
representing the device being pulled. If you don't see this, then this means there is no data
available for that device that can be shown in the available widgets.
3. You can also select and drag several devices at once by means of the usual mechanisms in
Windows or OSX for selecting several items. When you let them drop, the dialog that pops up
will show the widgets available that are common to all the selected devices or data channels.
4. Be careful that you correctly select the data channels that show the data you want to display.
For more details, see PVGuard®PVGuard®PVGuard®.
5. Once you have let the device or data channel drop, you can change the data it shows, or other
aspects of the widget, such as its colour, using the widget attributes panel on the lower right of
the program window.
6. As demonstrated with the label in the example above, you can also create a widget by pulling
one of the widgets from the Gallery tab of the Tabbed Toolbar onto the canvas.
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4 Working with Dashboards
This section explains the operations you can perform on a dashboard as a whole: creating, saving,
renaming, deleting a dashboard.

4.1 Opening a Dashboard in PVGuard
In the View Navigator you will find several folders named Dashboards in the hierarchy. These are
present at both the root (uppermost) level and also under individual plant folders. Any dashboard
designs you have already published will be listed under these folders.

Dashboards for a specific plant

Dashboards for several plants
or a whole plant portfolio

Fig 6: Opening a dashboard from the View Navigator in PVGuard

Double click the desired dashboard to open it, and it will be presented as a new View.

4.2 Creating a new Dashboard
If you want to create a new dashboard, click on the New... entry at the corresponding place in the
PVGuard View Navigator.
When showing data from several plants in your dashboard, you should create the dashboard under
the Dashboards entry at the topmost level of the View Navigator hierarchy. Otherwise, create it
using the Dashboards > New... command under a specific plant.
Creating a dashboard from Dashboard Designer
If you are already working in Dashboard Designer you can also create a new dashboard directly
from within it. Click on the Application Button at the top left of the program and use the New
Dashboard command. A new, blank canvas will be opened in the canvases area.

4.3 Opening a Dashboard for Editing
To open a dashboard from PVGuard, right-click on the dashboard name in the PVGuard View
Navigator, and select the command Edit from the context menu.
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Fig 7: The dashboards context menu in PVGuard

The Dashboard Designer will open with the selected dashboard open for editing.

4.4 Saving and Previewing your Work
Saving your Design
At a certain point you will want to save the work you have done. The commands for this are
located in the menu of the Application Button and function as usual: use the Save command to
initially save or re-save your design. To save a design under a different name of for a different plant
use Save As.
The dashboard will be saved on the skytron servers.
Previewing the Result
As you develop your widget or dashboard, you may want to see a preview of how it will appear in
actual use. You can easily do this by either:
• In the Quick Access Toolbar at the top left of the program window, using the preview button:
• Using the Preview command in the menu under the skytron Application button.

4.5 Deleting and Renaming Dashboards
Deleting a dashboard in PVGuard
To delete a dashboard, first locate its entry in the PVGuard View Navigator. Right click over the
entry, then in the context menu click Delete selected view.
Renaming a dashboard in PVGuard
When you publish a dashboard, you are asked for a name for the dashboard. This is the name by
which it will appear in the PVGuard View Navigator. To change its name later, locate its entry in the
PVGuard View Navigator. Then right click over the entry, and click Rename in the context menu.
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Changing which plant a dashboard is assigned to
Dashboards will be listed under a particular plant in PVGuard. To change this assignment, locate its
entry in the PVGuard View Navigator. Then right click over the entry, and click Change visibility/
Plant assignment in the context menu. A dialog will appear where you can change the assignment.
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5 Working with Widgets
Widgets are the basic building blocks of a dashboard. There are lots of different widgets available, and
the range will increase with time. Widgets are usually bound to a data channel for one of the devices
in a plant. You create your dashboard simply by arranging these widgets on the canvas in the way
you want. You can also link them together using connectors too, for example to show the direction of
energy flow through the plant.
Some widgets are very simple, like a text label, a data value, or a bar graph. Others might be more
complex such as a symbol for an inverter. Usually the more complex widgets are just a collection of
simpler widgets that have been grouped together. An inverter symbol, for example, might be made up
from simpler elements.
Image Status

Alias
Bar

Fig 8: An inverter as a Compound Widget

There are also widgets that let you display a picture you have imported into PVGuard, such as pictures
from your plant. You can even display a complete chart, just like those you can create in PVGuard.
So, for example, you could include a graph of the energy yield of your plant over a day/year in your
dashboard.
The rest of this chapter explains how you can insert and format a widget in your dashboard.

5.1 Inserting a Widget into your Dashboard
There are a number of ways to insert a widget using the Dashboard Designer.
1. Possibly the simplest way is to select a device or data channel from the Plant Explorer and then
drag it into the design's canvas.

Dialog
Drop in place

Pull device or
data channel
Device symbol
placed on canvas

Fig 9: Dragging a widget onto the canvas

When you drop the widget into place, a pop-up dialog will open which allows you to choose
what sort of widget is to be used to display the data. The choice will depend on the sort of data
channel you have chosen in the Plant Explorer.
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2. Alternatively, click on one of the widgets in the Gallery tab of the Tabbed Toolbar. Then,
holding the mouse key down, drag the widget into your design. Release the mouse at the
chosen place.

Pull device
from Gallery

Fig 10: Dragging a widget onto the canvas

In this case, after dropping it, you will have to change the properties of the widget manually to
those you want. You can do this in the Widget Properties pane of the program window.
3. Similar to the above, click on a widget in the Gallery, but release the mouse key before moving
the mouse. The widget will remain "stuck" to the mouse. Move the mouse to the point on the
canvas where you want the widget, and then click again with the mouse. Now you have two
options:
• Release the mouse straight away, and the widget will drop into position on the canvas.
• If you drag the mouse over the canvas before releasing the mouse key, the widget will be
automatically re-sized to match the size of the mouse drag. This allows you to insert and
resize a widget in a single operation.
4. Copy and paste an existing widget into the current design from this or another Dashboard. After
pasting it you will have to manually change the widget's data channel and other properties in
the Widget Properties pane (you can also change the data channel by dragging from the Plant
Explorer as described below).

5.2 Changing the Data Channel in a Widget
In a similar way to dragging and dropping a data channel from the Plant Explorer to create a new
widget, you can also drag a data channel into an existing widget. The widget will then show data
for the dragged data channel - as long as it has a compatible type.

5.3 Changing the Text in a Widget
If you want to change the text in a text widget such as a label, then select the widget and either:
• Click the text area once so that the text cursor appears.
• Press <ALT> and <RETURN> on the keyboard.
Note: The above instructions are based on a Windows operating system. Other operating
systems may involve slightly different mechanisms.
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5.4 Adjusting how a Widget looks: Widget Properties
Once you have created a widget for a device or data channel on the canvas, you may find it is not
showing exactly the data you want, or showing it in a different way to how you would like. The
Widget Properties pane on the lower right-hand side of the Dashboard Designer display allows
you to change many aspects about what data a widget displays, how it displays the data and how it
appears.

Fig 11: The properties pane

Whenever you select a widget - e.g. by clicking on it in the canvas or in the Hierarchy - then the
properties of the widget will be displayed in this pane.
The properties organized into categories that are shown as tabs at the top of the pane. The
categories shown depend on the widget. They include:
General

The core properties, such as name and type of the widget

Appearance

Properties that affect how the widget appears, for example,
colour, font, text alignment.

Behaviour

What data the widget is associated with and how that data is to
be presented (for example, with or without units being shown).

Content

Where you can define the content of a widget yourself - e.g. the
text in a text label, or a background image - this is where you can
set this up.

The values that you can enter for a property depend on the type of the property. In some cases
the value will be True or False (i.e. On or Off), represented by a tick box; others are more complex.
Often there is a helper to allow you to choose the value more easily. This will be shown by a ...
button at the end of the field for the value. An example would be a colour picker dialog that popsup to help you set the foreground or background colour.

5.5 Some of the Common Widget Properties
Tab

Property

Description

Title

The name given to this widget, as it appears in the widget hierarchy.

Description

What the widget does (read-only).

Layout Constraints

Describes the placement and size of the widget on the canvas (read-

General

only).
Appearance
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Tab

Property

Description

Border

What sort of a border appears around the widget. You can set
borders of a certain colour and width, choose to have no border, or
use an empty (transparent) border. (See also PVGuard®).

Foreground/

Lets you set the colour and transparency of any foreground (e.g.

Background Color

text) and background for the widget. The pop-up helper gives you a
choice of various colour pickers.

Opaque

Sets whether the widget covers those behind it (ticked), or whether
they are visible through it. The default is usually transparent.

Horizontal/Vertical

The alignment lets you set the position of the widget's content in

Alignment

relation to its defining frame or border.

Font

The Font property allows you to set the usual characteristics for a
font such as font face, size, style.

Behaviour
Data Source

Shows the data channel that the widget is bound to. For more

Component

details, see PVGuard®.

Show Unit

Whether the data value is shown with units or not.

Text for Data Gap

A test message you can use if there is no data available for a certain
date.

Unit

The units and scaling factor applied to them. For example,
temperature might be shown in °C or °F. Energy in kWh, MHh or
GWh.

Data Conversion

This property allows you to convert the data into another scaling or
unit by entering a formula. See PVGuard®.

Custom Component

This property allows you to give the widget a particular name. It will

Alias

be displayed in the tooltip for the component, and in some cases
elsewhere on the component, for example, the fascia of a gauge.

5.6 Binding Widgets to Plant Data
Most widgets will be associated with some component in one of your plants, for example with an
inverter, or with a data channel for the whole plant like Energy Yield. This association is known as
the Data Binding.
If you insert a widget into your dashboard by pulling it from the Plant Explorer, then the binding to
that data channel will be created automatically. However, if you create it by pulling a widget from
the Gallery in the Tabbed Toolbar, then you will have to set it up yourself. Alternatively, if you
copy and paste a widget, then it will retain the original data binding, and you will have to change
this manually to show data from a different data channel or device.
The data binding is set or changed through the Data Source Component property of the Behaviour
tab in the widget's properties. Click on the ... button to change this. A dialog will open which allows
you to select the data channel to be bound to the widget.
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You can also pull a data channel from the Plant Explorer into an existing widget in your design. If
the data channel is suitable for the widget, it will overwrite any existing source in the Data Source
Component property.
Note: Only those data channels that are suitable for particular type of widget can be bound
to it. So, if the widget represents a whole device, such as an inverter, the correct data
channels for an inverter will be available. A widget that is not bound to any data will be
marked with a cross:

5.7 The Context Menu for Widgets
If you hold the mouse over a widget and then right-click over it, then a context menu will appear.
The buttons symbolise the common operations you might want to carry out on a widget, for
example:
Bring to Front
Send to Back
Bring Forwards
Send Backwards
Delete
Cut
Copy

Fig 12: The widget context menu

•
•
•
•

Cut or copy the widget to the clipboard
Delete the widget (a confirmation prompt will be shown)
Move its order forward/backward, so that it appears over/under another widget
Move it right to the front or back, so that it appears over or behind all other widgets at that
point

5.8 The Widget Hierarchy Pane
If you are designing a large or complex dashboard, it can quickly become dense with widgets and
complicated to work on. The Widget Hierarchy pane on the right-hand side of the Dashboard
Designer can help you navigate around your design.
All widgets in your design are presented as a list here. Clicking any widget in the list will also select
that widget on the main canvas. The order of the widgets in the list also determines how widgets
will appear over others; those at the top of the list will appear above those further down.
Tip: A good tip is to name the widgets in a clear and sensible way; they will then be easy to
find in the Hierarchy.
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5.9 The Context Menu for the Widget Hierarchy
The entries on the list have a context menu, which you can open by right-clicking on any entry.

Fig 13: The Widget Hierarchy Context Menu

The entries are:
Lock/Unlock

Locking a widget can be a useful safeguard against inadvertent
modifications; locked widgets can no longer be selected or edited.
Once locked, a widget can only be unlocked from the widget
hierarchy.
You can also lock a widget by selecting it (or several widgets) and
then clicking Lock in the Widget > Modify group of the Tabbed
Toolbar.

Embed/Reference

This control determines whether the widget will be embedded
in the dashboard design or whether a reference version is used.
In the latter case, the reference version is stored separately
to the current dashboard, and more than one dashboard can
reference it. This means that if the reference version is changed,
all designs using it would change too. If you embed a widget (the
default), then changes to the reference version will not affect
your dashboard. You could later incorporate any changes by
changing the Reference control again.

Rename...

Allows you to rename the widget. Though not mandatory, it is
good practice to ensure that each widget has a unique name.

Copy, Paste, Cut, Delete

Allow you to cut and paste the widget either into the same
dashboard or into another one.

Note: If you cut and paste a widget, it will still be bound to the same device as the original.
Remember to change the field Behaviour > Data Source Component in the widget's
Properties.
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6 Laying it Out
This chapter gives you some tips about the features available when designing a dashboard to help you
achieve the effects you want.

6.1 The Grid
The Dashboard Designer provides a grid to enable you to easily align widgets horizontally and
vertically. The grid is marked by the dots on the background canvas of the dashboard. If you click
on one of the handles on the edge of a widget and pull them, these will automatically snap to the
nearest grid vertices. If you move a widget by clicking and dragging it, then the position of the
whole widget will snap to the nearest grid point at the new location.

6.2 Widget Order
When laying out your dashboard, you can place widgets over one another. In this case what you
see on the canvas will depend on the order of the widgets. This order is set by the order of the
widget in the Hierarchy pane. Those at the top of the hierarchy will appear on top of those lower
down the hierarchy. You can change the order of widgets by:
• Selecting the widget in the Widget Hierarchy Pane and pulling it up or down in the list. Those at
the top appear over those lower down.
• Selecting the widget you want to move and then clicking on the Layer button in the Widgets >
Modify group of the Tabbed Toolbar. You can then use the commands there to move the
widget towards the top, or push it down.
• Right-click the widget. If it is lying behind or in front of other widgets, then commands will be
available in the context menu to move it forward or backward.
If you use either of the last two methods, you will see the widget move in the Hierarchy pane after
you have moved it towards the top or bottom.

Fig 14: Order of widgets on the canvas and in the Hierarchy pane

6.3 Transparency
Widgets usually consist of an active part - for example the text in a label, or the content of a gauge
- and a background. Usually there will be properties available to:
• Set whether the background is transparent or opaque; that is whether you can see the widgets
below the top one, or whether it completely blocks them out.
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• Set the colour of the background. This will only apply if the widget is opaque.
• Set whether the widget border is visible, and set its the colour and width. Widgets may have 3
border settings:
1. Coloured border, where the border has a set colour and width
2. No border, where the background colour fills right to the widget's edge
3. Empty border, where there is a border area, but it is transparent, letting any widgets below
show through

The picture shows a widget with (left) No border (center) Solid Border (right) Empty border.

Fig 15: Different types of border
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7 Getting the Data Right
When creating dashboards it's essential that you ensure that you display the data correctly, and in the
way you want. This chapter gives you some tips and advice concerning the choice of data and how to
display it correctly.

7.1 Choosing the Correct Data Channels
First, you need to ensure you are displaying the correct data channels from PVGuard. In principle
this is easy, just pull the data channel from the Plant Explorer into your design. However there are
a few things to watch out for.
Channels with Energy Data
Energy channels show the accumulated energy generated by the plant or one of its components
since a certain date or time. There are usually a number of these channels available: some may
show the accumulated energy since the start of logging; others may just show the energy produced
today; these will be reset to zero each night.
When energy channels are displayed in PVGuard usually they are shown with the Delta aggregate
applied. This means the chart actually shows the change in energy, giving a typical "bell" shaped
curve over a day as shown in Fig 16: Energy Data, Delta Aggregate and Power, on page 21.
However, the widgets available for dashboards do not always include the ability to apply aggregate
functions to the data - the value returned is the last raw data value.

The chart shows how the delta aggregate of the energy data has a similar shape to the power output.

Fig 16: Energy Data, Delta Aggregate and Power

So, for example, if you include plant a data channel for plant energy production and want to show
it on a circular gauge display, the value will rise from zero at the start of the day, and steadily rise
as the day progresses, finally dropping to zero again at midnight.
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If you want to include data similar to the PVGuard display for energy output, then we recommend
you use the equivalent Power Output data channel for the widget, which will produce the expected
bell-shaped curve.
Note however, that charts included in dashboards do include the ability to show data with the
delta aggregate applied.
Irradiation
Similar arguments to energy output channels also apply to the data channels used for irradiation.
Most widgets will display the irradiation energy channels as the accumulated energy. If you wish to
show data for the changes in the irradiation energy change, we recommend you use the irradiation
power channels unless you are using a chart widget.
Performance Ratio
Values for the Performance Ratio show the result of a calculation based over the past minute's
data. The data therefore shows a Performance Index, and not a true Performance Ratio, which
needs to be calculated over a much longer aggregated time.

7.2 Applying a Conversion Factor
Many widgets include the ability to apply a data conversion to the data before it is displayed. For
this, a data conversion formula can be defined in the Widget Properties pane. Examples for this
include:
• Converting between one sort of unit and another (e.g. kWh to J), where this is not automatically
supported.
• Changing the scaling factor on the data units (e.g. kWh to MWh) to a non-standard scaling.
• Calculating a monetary value based on a feed in tariff (e.g. 200 kWh at $x per kWh).
Proceed as follows:
1. Select the relevant widget.
2. In the Widget Properties panel, find the Data Conversion property (under the Behaviour tab).
3. Enter the formula for the conversion into this property; it has the form:
y = x * multiplier unit1/unit2 + offset
Here:
multiplier

Is a number such as 2 or 3.412.

unit1

Are the output units, for example €

unit2

Will be the units of the data channel, but at an appropriate
scaling e.g. kWh, MWh

offset

Is also a number such as 2 or 3.412. This is a fixed constant
that will be added to the result (in the output units).

(In these calculations the decimal point symbol should match that used in general on your
computer.)
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8 Jazzing it Up: Adding Graphics
To make your dashboards look really attractive they can include your own graphics, pictures or charts.
These might include your company's logo, pictures of the plant or site, sketches of the equipment etc.

8.1 Graphics in Dashboards
Storage of dashboard Graphics
Graphic images in any of the standard formats can be used in dashboards: '.jpg', '.png' or bitmaps.
When you import an image from your PC, it will be uploaded into the skytron Cloud. A tool is
available to manage these images in the skytron Cloud.
You can include an graphic image by:
• Importing the graphic or picture file directly into Dashboard Designer from your PC
• Using an image that has already been imported - either by yourself or as a standard image
• Referencing an image in the internet through its Uniform Resource Locator - URL (e.g. http://
www.mysite/picture.jpg)
If you add an image from a file, the Dashboard Designer includes in-built capabilities to crop, scale
and rotate the image.
Note: The scaling, cropping and rotation operations are only applied to the image when
PVGuard actually displays the dashboard - the original image, stored in the skytron Cloud, is
unchanged.
Ways to Add a Graphic
There are two ways to include a graphic:
• Click on the Picture button in the Widget > Insert group of the Tabbed Toolbar. This will open
the Insert Picture Wizard at the start, which will let you choose the source of the image.
• Drag and drop an image from your computer into the canvas. The image will automatically be
uploaded and the Insert Picture Wizard will be started, except that the first step - choosing the
source of an image - will be skipped.
The wizard is described below.

8.2 The Insert Picture Wizard
A wizard has been provided to assist you inserting an image. Open this by using the Widget >
Insert > Picture button in the Tabbed Toolbar. The wizard first page of the wizard, shown below,
will open.
During the wizard you will have the opportunity to adjust the image for use on your dashboard.
You can Crop, Scale or Rotate it.
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Fig 17: The Insert Picture Wizard, first page

Wizard Page 1: Selecting the source of your image
Choose the source of your widget as described below. In each case, use the Browser control at the
right of the option to select:
Picture File

The browser will let you choose a file from your PC or network.
On clicking Next, the file will then be uploaded into the skytron
Cloud repository, meaning that you can easily re-use the same file
in this or any other dashboard.

skytron Cloud

This opens the Cloud Browser through which you can choose any
of the pictures that have already been uploaded into the skytron
Cloud - either from Dashboard Designer or from other sources.

Internet

Here you can enter a URL for you file in the internet, for example
"www.mywebsite.com/images/logo.jpg".

Wizard Page 2: Cropping the image
If you just want to show a small segment of a picture in you dashboard - for example a small
section of a site map, you can use the cropping tool. The picture will open with a rectangular
window over it.

Fig 18: Using the cropping handles

The part of the picture to remain is highlighted, and the part to be cropped out is dimmed. There
are spherical handles you can pull at the corners of the selection. Dragging the double arrow
symbol will move the whole selection.
Click on one of the spherical handles at the corners of the pictures, and pull it to the corner of the
area to be displayed. The part of the picture shown dimmed will be cropped from the final image in
the dashboard; only the highlighted section will be shown.
Alternatively, use the controls at the bottom of the dialog to set the exact origin and dimensions of
the area you want to display.
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Wizard Page 3: Scaling the image
On the third page of the wizard you can enlarge or shrink the image's displayed size. Use the
numeric spin-box controls to enter the size of the image as it should appear. By default, the width
and height will scale together; click the padlock control to unlock this association if you wish to
scale width and height independently. If you make a mistake, the Reset Scaling button will restore
the image to its original size.

Fig 19: Scaling the image

Wizard Page 4: Rotating the image
Lastly, you can rotate the image if you want. In particular, this allows you to turn an image upside
down (180 degree rotation).

Fig 20: Image rotation

Finally click Finish. If you have chosen to use a picture from a disk from your computer, it will be
uploaded at this point onto the skytron Cloud server.
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9 Showing the Trend: Adding Charts
One of the key features of PVGuard is its ability to display dynamic charts of your plant's data. This is
available too in Dashboard Designer using the Chart command. By using charts you can leverage the full
power of PVGuard on your dashboard.

9.1 How to Add a Chart
Using the Insert Chart Wizard
A wizard has been provided to assist you inserting an chart. Open this by using the Widget >
Insert > Chart button in the Tabbed Toolbar. The wizard will open as shown below.

9.2 Insert Chart Wizard
Wizard Page 1: Selecting the Data Channels
On the first page of the wizard you can choose which data you wish to show in the chart. The lefthand pane shows a version of the Plant Explorer. Select the data channels that you wish to show in
your chart. Either drag the selected channels into the Selected Ids pane on the right-hand side, or
press the button to do this. The channel will appear in the list on the right.

Fig 21: Selecting data for your chart

To remove data channel from a chart, select it from the list on the right, then press the button.
Tip: It's a good idea only to show those data channels you really need. The more channels
you include have in a chart, the longer it will take to load and update its data.
Wizard Page 2: Configuring how the data is shown
The second page of the chart allows you to configure how the data is shown on the form. It is
separated into three regions:
• Time Settings at the top.
• Charts in the right-hand tab of the chart display.
• Values in the left-hand tab of the chart display.
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Fig 22: Choosing how to display the chart data

Time Settings
Here, you set the period for which the data is to be shown (left-hand selector), and the resolution
of the data points on the chart (right-hand selector). The usual combinations of period and
resolution that you can use in PVGuard are available, for example year-by-month or day-by-hour.
Tip: Think carefully about what period and resolution you actually need - the more data
points you have on a chart, the longer it will take to load its data.
Charts
Here, you can set what sort of chart is to be shown and what data is to be shown on which axis.
The exact fields available in the remainder of the form will depend on the chart type. They include
the following:
Plot Type

Typical charts in PVGuard use a 2D Scatter Plot, but you can
choose one of a number of other chart types in this field. Some
examples are shown in Example Chart Types.

X-Axis

The horizontal axis. For a standard plot of historical data,
the x-axis should be set to time; however if you want a more
sophisticated XY scatter plot, then you can choose a different
data channel here. You can also plot the data on a logarithmic
scale.

Y-Axis

This shows which data is shown on the vertical (Y) axis. In a MultiScatter plot you will be able to enter more than one data channel.
If you need, you can plot this on a logarithmic scale.

Color Axis

This allows you to change the color of the points on the chart
according to the value of one of the data channels.

Sector Size

On pie charts, this determines which data channel is used to
determine the size of the pie sectors (also called slices)

Connect Points by Time

If this is checked, the data points on a 2D chart will be joined up.
Otherwise just the data points will be shown with no lines.

Values
Unit

Here, you can set how the units will be scaled for that data
channel, for example, whether power is shown as W, kW or MW.
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Aggregate

In the same way as in PVGuard, the choice of Aggregate allows
you to choose how the value for a point on the diagram is
calculated from all the points in the raw data for that time period.
For example, the value for a day might be calculated as the
minimum, mean or maximum, of 288 5-minute data samples.

Example Chart Types
The following illustrations give a few examples of the types of chart that can be created.

Fig 23: Historical Data Chart

Fig 24: Historical Chart with a Colour Axis

Fig 25: Pie Chart
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10 Joining Everything Together: Using Connectors
If you are creating mimic diagrams you will usually want to show some sort of flow. This might be the
energy flow through the plant - from solar module to grid insertion point. Alternatively you might want
to show the flow of the monitoring information from the original equipment to the data loggers. You
may want to show a flow in other diagrams too, for example the physical roadways and paths through
your sites.

Connectors can be used to show the flow of power in a mimic diagram

Fig 26: Plant Mimic using Connectors

10.1 How to Add a Connector
The Connection Tool allows you to connect up the widgets on your dashboard to show such a flow
and how the elements of your diagram relate to one another.
Click on the Widget > Insert > Connection button in the Tabbed Toolbar. The mouse pointer will
change to the connection pointer: .
Click the mouse on the first (upstream) widget you wish to connect, then pull it to the downstream
widget and release it. A connector will follow the mouse as you drag it. After you release the
mouse the connection will be finalized between the two widgets. Once you have joined two
widgets with a connector, they will stay joined even if you move one or both of them on the
canvas.

10.2 The Connector Type
Connectors can be drawn in one of two ways:
• As a Line connector. This initially connects using a single line using the shortest path between
the two widgets. However you can manually adjust the shape of the line by adding additional
points, described below.
• As a Right-Angled connector. This will draw the connector using just horizontal and vertical
line segments. This may be clearer in some designs and also if a printed output is required. The
routing is done dynamically by PVGuard when creating the dashboard as a view, and so will
scale automatically.
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The pictures below illustrate lines of type: Line, Right-Angled, and manually adjusted.

Fig 27: Line, Right-Angled and manually-adjusted Line connectors

Using the Line Mouseover Tooltip
Once you have created a connector, if you select it by clicking it and let the mouse hover over it, a
tooltip will pop up with buttons that allow you to:
• Change the connector type to Line
• Change the connector type to Right-Angled
• Delete the connector
Line Connector
Right Angle Connector
Delete

Fig 28: Connector tooltip over line

Manual Connectors - Adding Points
When you use a Line connector, you can also adjust it manually by adding one or more points in the
middle of the line. To do this, either:
• Double click the line at the point where you want to insert the point
• Select the line, then right-click with the mouse and click the Create Point symbol
Once you have created a point, you can click on it and then pull it with the mouse to the desired
position. Points will automatically snap to the nearest grid point on the canvas.
To remove a point, right-click on it with the mouse, then click the Remove Point symbol.
Add Point
Delete Point
Connector Type
Delete

Fig 29: Connector tooltip over point

10.3 Fine Tuning: Connector Properties
Like all other widgets, if you select a connector, then its Properties will become visible in the
Widget Properties pane at the bottom right of the program window. They enable you to adjust
other features of the connector. Here, you will be mainly interested in those in the Appearance
tab.
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Property

Description

Line Color

Lets you change the color of the line. Clicking the button will open
a color-picker dialog. Alternatively you can enter a value, in the
form [Red, Green, Blue, Alpha], where Red, Green and Blue are
the respective values for the color components (0-255), and Alpha
is a value for the transparency (also 0-255; 0 = transparent).

Line Style

Clicking the button will pop-up a dialog in which you can change:
• The connector type
• The line thickness in points
• The dash step - whether the line will be solid (0) or dashed,
and what sort of dashes are used
• The arrow width for any arrows at the line start/end (0 = no
arrow)
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11 Reference: Toolbar and Canvas Functions
11.1 Tabbed_toolbar
The Insert Group

Fig 30: The Insert Group

Picture

Opens a wizard that lets you insert and adjust a picture, either
from your local PC, from the skytron Cloud, or from the Web.

Chart

Lets you set up a chart, on your dashboard, for example, to show
Today's Energy Yield.

Connection

The connector tool lets you show the order or direction of flow
between widgets using arrowed lines.

The Modify Group

Fig 31: The Modify Group

Delete

Deletes the selected widget (after confirmation).

Cut, Copy, Paste

Standard operations using the clipboard.

Select All

Selects all widgets on your canvas.

Layer

Lets you bring the visibility of a widget towards the
front, or move it towards the back. Will determine
which widgets can cover others. For more details see
PVGuard®PVGuard®PVGuard®PVGuard®

Lock

Locked widgets cannot be edited any more, or even be selected
on the canvas until they have been unlocked. This allows you to
protect widgets against accidental changes. Select the widget(s)
you wish to lock and press this button.
To unlock a locked widget you must use the Hierarchy pane. For
more details see PVGuard®

The Gallery

Fig 32: The Gallery
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Presents the selection of available widgets. On the right hand side are controls to allow scrolling
through the widgets, or (bottom button) to open the Gallery in a single pane.
Font Formatting group

Fig 33: The Font Group

These commands allow you to format the text used in widgets. The usual font formatting options
are provided: Font name, size, and style. There are also tools to increase and reduce the displayed
font size.
Select the text to be formatted with the mouse, and apply the formatting you want.
Note: The font used in a widget may also be defined by the Font property in the Widget
Properties.

11.2 The Quick Access Toolbar
The Quick Access Toolbar at the top of the program window provides the following functions:
Creates a new dashboard.
Saves your dashboard design.
Allows you to see a preview of how your dashboard will look.

11.3 Working with Multiple Canvases
If you are working on more than one design at once, then the canvas controls at the top right of
the canvas area may help you.
Fig 34: Canvas Controls

These controls are (from left to right):
Left Arrow

Move to previous (left-hand) canvas

Right Arrow

Move to next (right-hand) canvas

Down Arrow

Presents a list of all open canvases, where you can select one to
become the active, working canvas.

Window

Expands the current window to fill all of the program window
under the tabbed toolbar. After use changes into a restore
button.
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